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1.	 Introduction

Thank you for purchasing the permanent Sound Insulation Option or the annual Sound Insulation 
Reporter 365 license for the XL2 Sound Level Meter. This enables the import of the measurement 
data into the Sound Insulation Reporter PC-software. The Sound Insulation Reporter is a PC-based 
software application that provides all the reports for airborne, impact and facade sound insulation 
measurements.

Designed for acoustic consultants, this comprehensive tool uses data gathered by the XL2 Sound 
Level Meter, and quickly returns graphical analysis of all measurement positions. Analyzing the mea-
surement data and producing reports is straight-forward using the Sound Insulation Reporter soft-
ware. Just drag & drop the XL2 measurement data into the software and print the report. 

Additionally, the software offers remote measurements; one or more XL2 Sound Level Meters may 
be controlled directly by the software connected via USB or wireless. This offers parallel measure-
ments of sending and receiving room onsite, thus a great time saving. 

The following tutorial provides a step-by-step instruction. The appendix provides more details on a 
typical onsite measurement procedure.
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2.	 Standards

The Sound Insulation Reporter software measures and reports in accordance with the following 
standards:

Airborne 
Sound Insulation

Impact 
Sound Insulation

Facade  
Sound Insulation

•	 ASTM E336-20

•	 ASTM E413

•	 ASTM E1007

•	 ASTM E989

•	 ASTM E966

•	 ASTM E1332

•	 DIN 4109 •	 DIN 4109 •	 DIN 4109

•	 England/Wales:  
Approved Document E 
(2003)

•	 BB93

•	 England/Wales:  
Approved Document E 
(2003) 

•	 BB93

•	 GB/T 19889.4 - 2005 •	 GB/T 19889.7 - 2005 •	 GB/T 19889.5 - 2006

•	 ISO 10140:2021 •	 ISO 10140:2021

•	 ISO 140-4:1998

•	 ISO 717-1:1996

•	 ISO 140-7:1998

•	 ISO 717-2:1996

•	 ISO 140-5:1998

•	 ISO 717-1:1996

•	 ISO 16283-1:2014 
incl. Rooms < 25m3

•	 ISO 717-1:2021

•	 ISO 16283-2:2018 
incl. Rooms < 25m3

•	 ISO 717-2:2020

•	 ISO 16283-3:2016 
incl. Rooms < 25m3

•	 ISO 717-1:2021

•	 NEN 5077:2019 •	 NEN 5077:2019 •	 NEN 5077:2019

•	 SIA181:2006

•	 SIA181:2020

•	 SIA181:2006

•	 SIA181:2020

•	 SIA181:2006

•	 SIA181:2020
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3.	 My First Steps

Sound Insulation is the measurement of the influence that a partition (usually a wall or ceiling) has 
on sound; in other words, how efficiently a partition insulates the sound between rooms. To evaluate 
this, a reference sound signal is generated in the sending room, and the noise spectrum is mea-
sured in both the sending and the receiving room. Additionally, a room correction of the receiving 
room is applied based on the measurement of the reverberation time.

The Sound Insulation Reporter software offers the following measurement modes:

•	 Automated Measurement (XL2 remote controlled) 
One or more XL2 Sound Level Meters may be controlled directly by the software connected via 
USB or wireless. This offers parallel measurements of sending and receiving room onsite.

•	 Manual Measurement with XL2 
The measurements are performed manually with the XL2. All data is later on imported into the 
Sound Insulation Reporter software.

Software Installation
•	 Install the Sound Insulation Reporter software on your PC.

XL2 Sound Level Meter Requirements
•	 Install the optional Extended Acoustic Pack for reverberation time measurements in 1/3 octave 

resolution. 

•	 Install the Remote Measurement Option as required. This enables controlling one or more XL2s 
from the Sound Insulation Reporter software.

•	 Install the permanent Sound Insulation Option on the XL2 or request the online activation of the 
annual Sound Insulation Reporter 365. This enables the data import into the Sound Insulation 
Reporter software.

•	 Install the latest XL2 firmware V4.84. For XL2-TA Sound Level Meters use the latest certified 
firmware V4.71 - Austria and France requires V4.21.
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4.	 Measurement Configurations

Sound insulation measurements may be performed in various configurations.

Simultaneous Measurement in Sending- and Receiving Room
The simultaneous measurement configuration reduces the measurement uncertainty; the noise 
level is measured in both rooms at the same time. These are the recommended configurations:

•	 Automated Simultaneous Measurement 
(configuration is remotely controlled by one person)

	- 1x Dodecahedron Speaker Set

	- 2x XL2 Sound Level Meter

	- 2x M2230 Measurement Microphone

	- 2x Extended Acoustic Pack

	- 2x Sound Insulation Option

	- 2x Remote Measurement Option

	- 2x ASD Cable 5m (alternatively 10m or 20m)

	- 2x Mains Power Adapter XL2

	- 2x Exel System Case

	- 1x Windows Computer, Laptop or Tablet 
(to start/stop measurements live in Sound Insulation Reporter)

	- 1x Wi-Fi Access Point (generating Wi-Fi network, e.g. SILEX SX-ND-4350 WAN) or  
USB Device Server (using existing Wi-Fi network); available at your preferred supplier

•	 Manual Simultaneous Measurement  
(measurements are performed by two persons - one in each room; all measurement data is 
loaded into Sound Insulation Reporter software after completed measurement)

	- 1x Dodecahedron Speaker Set

	- 2x XL2 Sound Level Meter

	- 2x M2230 Measurement Microphone

	- 2x Extended Acoustic Pack

	- 2x Sound Insulation Option

	- 2x ASD Cable 5m (alternatively 10m or 20m)

	- 2x Mains Power Adapter XL2

	- 2x Exel System Case

	- 1x Windows Computer, Laptop or Tablet 
(to analyze data in Sound Insulation Reporter after completed measurements)
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Sequential Measurement of Sending- and Receiving Room
The Dodecahedron Speaker Set provides the test signal at continuous sound pressure level for long 
time; e.g. 1 hour. This supports precise sound insulation readings at measuring the sending and re-
ceiving room sequentially. These are the recommended configurations:

•	 Automated Sequential Measurement 
(configuration is remotely controlled by one person)

	- 1x Dodecahedron Speaker Set

	- 1x XL2 Sound Level Meter

	- 1x M2230 Measurement Microphone

	- 1x Extended Acoustic Pack

	- 1x Sound Insulation Option

	- 1x Remote Measurement Option

	- 1x ASD Cable 5m (alternatively 10m or 20m)

	- 1x Mains Power Adapter XL2

	- 1x Exel System Case

	- 1x Windows Computer, Laptop or Tablet 
(to start/stop measurements live in Sound Insulation Reporter)

	- 1x Wi-Fi Access Point (generating Wi-Fi network, e.g. SILEX SX-ND-4350 WAN) or  
USB Device Server (using existing Wi-Fi network); available at your preferred supplier

•	 Manual Sequential Measurement  
(measurements are performed by one person; all measurement data is loaded into Sound Insu-
lation Reporter software after completed measurement)

	- 1x Dodecahedron Speaker Set

	- 1x XL2 Sound Level Meter

	- 1x M2230 Measurement Microphone

	- 1x Extended Acoustic Pack

	- 1x Sound Insulation Option

	- 1x ASD Cable 5m (alternatively 10m or 20m)

	- 1x Mains Power Adapter XL2

	- 1x Exel System Case

	- 1x Windows Computer, Laptop or Tablet 
(to analyze data in Sound Insulation Reporter after completed measurements)
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5.	 Manual Measurement with XL2

Mapping File for XL2
The measurement task onsite is made up of a several separate measurements. The XL2 Sound 
Level Meter may assign each of these measurements with a dedicated mapping, e.g. “L1-1” for the 
readings taken in the sending room with speaker position 1. This feature supports automated post-
processing and reporting in the Sound Insulation Reporter software. 

•	 Load the text file “savenames.txt” with the user defined mapping, such as “L1-1”, “L1-2”,..., into 
the root directory of the XL2. The text file “savenames.txt” may be generated by the Sound 
Insulation Reporter software:

	- Click on Settings

	- Select the tab Mapping

	- Click Export

•	 Load the txt-file “savenames.txt” with the various mappings onto the root directory of the XL2. 

SOUND INSULATION REPORTER
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•	 Next select “Autosave: Off” in the XL2 memory menu. This allows you to store each individual 
measurement with the desired mapping. The XL2 then uses the same mapping for subsequent 
measurements by default.
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Set XL2 Memory Structure for Multiple Partitions
In applications with multiple partitions, it is recommended to use a separate memory folder on the 
XL2 Sound Level Meter for each partition. All measurements belonging to a single partition are then 
stored in the same folder on the XL2 memory card. Measurements belonging to multiple partitions 
can be later copied into the individual partition folders on the computer. Each partition will be an 
individual project later on in the Sound Insulation Reporter software.

•	 Connect the XL2 to the computer and select “Mass Storage”

•	 Open the folder “Projects”

•	 Generate new subfolders for each partition, e.g. Partition 1, Partition 2, PartitionRoom 1-2, ...

Instrument Settings
•	 A dedicated profile for Sound Insulation Testing is available for download here. This includes 

all required instrument settings for successful measurements. Importing the profile into your 
Sound Level Meter is described in the XL2 User Manual; search for “Import MyProfile from PC”.

•	 Alternatively, you can configure the XL2 manually. Set the reporting to Add Spectra: All. No 
specific settings for the broadband report levels are required (Report Values) - these levels are 
not required for sound insulation testing.

SOUND INSULATION REPORTER

USER MANUAL

https://my.nti-audio.com/support/xl2/download/Profiles/Sound-Insulation.prfl
https://www.nti-audio.com/Portals/0/data/en/XL2-Manual.pdf


www.nti-audio.com Page 12 / 97

Perform Noise Spectrum Measurements
•	 Select the SLMeter measurement function on the XL2.

•	 Select the RTA screen and 1/3 octave resolution measurements.

•	 Ensure the frequency weighting “Z” is selected (= no weighting).

•	 Start the measurement (hint: best use the single timer setting).

•	 Stop the measurement after 15 seconds.

•	 Open the memory menu and select “Save Test”

•	 The XL2 displays the Save Test pop-up; select “Sound-Insul” at the right end of the first line.

•	 Select the applicable mapping

•	 Confirm your selection with the enter key and save the measurement. The XL2 saves the mea-
surement data with a file name such as “L1-1_SLM_003_RTA_3rd_Report.txt”

•	 Continue with the further measurements “L1-2..., etc.“ in the same manner.
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Perform Reverberation Time Measurements
•	 Select the RT60 measurement function on the XL2.

•	 Select 1/3 octave resolution (requires the optional Extended Acoustic Pack pre-installed in the 
XL2).

•	 Start the measurement.

•	 Stop the measurement.

•	 Open the memory menu and select “Save Test”

•	 The XL2 displays the Save Test pop-up; select “Sound-Insul” at the right end of the first line.

•	 Select the applicable mapping

•	 Confirm your selection with the enter key and save the measurement. The XL2 saves the mea-
surement data with a file name such as “T2_RT60_000_Report.txt”

•	 Continue with the further measurements in the same manner.
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Data Import
The XL2 measurement data may be imported into the software by drag and drop. The minimum re-
quirement for a successful data import is an XL2 with firmware V4.03 or higher and activated Sound 
Insulation Option. Instruments using an older firmware may benefit from the online activation of the 
option without installation on the device. The Sound Insulation Reporter software verifies the avail-
able option online during the data import. Any recorded data with A- or C-weighting is automatically 
corrected to Z-weighting (=no weighting).

•	 Start the Sound Insulation Reporter software.

•	 Click on File -> New

•	 Select your requested Standard

•	 Select Airborne, Impact or Facade Sound Insulation.

•	 Select the number of Speaker positions used.

•	 Select Unit.
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•	 Define the required Results.

•	 Select the preferred Rating Format. Choose either Dw(C;Ctr) = 41 (-1;-3) dB or   
Dw = 40.5 dB +/- 0.9 dB. 

•	 Confirm with OK.

	

	The measurement view with the message “Drop measurement files or folder here” is displayed.

Kindly ensure, prior the data import, that the partition folder contains all required measurement data 
(*.txt) and *.xl2 system files of each recorded measurement. 

•	 Drag and drop the complete partition folder from the XL2 memory card into the field Drop mea-
surement files or folder here.  The partition folder should include the noise spectrum data, the 
reverberation time data and the *.xl2 system files.

Sound Insulation Reporter offers further possibilities to import measurement data:

•	 Select all *.xl2 files in the partition folder with all measurement data. Drag and drop the data 
into the Drop measurement files or folder here field.
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•	 Click on Import in the main window and select the partition folder. Confirm the selection.

•	 Click on Import in the main window and open the partition folder. Confirm the selection.

•	 Click on File -> Import and select the folder, single or multiple data files. Confirm the selection.

	The measurement data is imported.

All measurement data with mapping information in the file name are assigned automatically by the 
software, e.g. “L1-1_SLM_001_RTA_3rd_Report.txt” is assigned to L1-1 (=speaker position 1 in the 
sending room). Alternatively, the mapping may be assigned manually to sending room or receiving 
room and the individual speaker positions:

•	 Select the measurement with the mouse

•	 Click on the right mouse button

•	 Select Assign To 

•	 Assign the measurement

•	 Verify the measurement data and delete any false readings from the Measurements list on the 
right.
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Measurement Report
•	 Select View -> Calculations in the menu.

•	 Verify the individual averaged results.
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•	 Select the View -> Results. 

		The sound insulation data and chart are displayed.

•	 Complete the header data with information about client, object, description, partition area and 
room volumes.

•	 Print the sound insulation report.

	Congratulations, your report is completed! 
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6.	 Automated Measurement (XL2 remote controlled)

The Sound Insulation Reporter software offers remote sound insulation measurements. One or 
more XL2 Sound Level Meters may be controlled directly by the software. For example, one XL2 is 
positioned in the source room and another one in the receiving room for airborne sound insulation 
measurements. The communication is wireless. The connected XL2s require an activated remote 
measurement option.

Configuration
Speaker and Microphone Configuration
The sound spectra in the source room and the receiving room are measured simultaneously by in-
dividual XL2 Sound Level Meters. The Sound Insulation Reporter Software controls the instruments 
and visualizes the live measurement data.

Source Room Receiving Room

SpeakerPosi-
tion 1

Mic 
Position 3

Mic 
Position 3

L1 L2

SOUND INSULATION REPORTER
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Case A) Instrument Configuration “External Wi-Fi network available”
If a Wi-Fi network is already available at the measurement location, you may connect the XL2 (and 
optionally the PA3 power amplifier) in the source room to the controller PC (notebook) in the receiv-
ing room by using a Wi-Fi connected USB Server.

Source Room Receiving Room

L1 L2

XL2

Notebook

USB

Wi-Fi connected  
USB Server

USB

XL2

PA3

(optional)

LAN

Case B) Instrument Configuration “Local Wi-Fi network”
If no external Wi-Fi network is available, you may establish your own local Wi-Fi network by using a 
portable Wireless Access Point. This device connects the XL2 (and optionally the PA3 power ampli-
fier) in the source room to the controller PC (notebook) in the receiving room.

Source Room Receiving Room

L1 L2

XL2

Notebook

USBUSB

XL2

Wireless 
Access PointPA3

(optional)

LAN

SOUND INSULATION REPORTER
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Recommended setup procedure for Wireless Access Point “SILEX SX-ND-4350 WAN”
1.	 Download and install the “SX Virtual Link” software.

2.	 Connect the SILEX Wireless Access Point to AC mains.

3.	 Connect the XL2 via a USB cable to the SILEX Wireless Access Point, and optionally also the 
PA3 via an Ethernet cable.

4.	 Switch ON the XL2, select the “COM port” mode and wait, until the  LED on the SILEX Wire-
less Access Point starts flashing.

5.	 Run the SILEX SX Virtual Link software on the controller PC (notebook).

6.	 In the control panel of the SILEX SX Virtual Link software, click on “NTi Audio AG XL2 Remote”, 
then on the “Connect” button.

7.	 Right click on “NTi Audio AG XL2 Remote” to open the “Remote Properties” panel; therein, 
click on “Device Server Properties”.

8.	 Press the Enter key to log in (no password required).

9.	 Adjust the settings as shown on the next page.
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Product Configuration for Wireless Access Point type “SILEX SX-ND-4350 WAN”

1.	 Select the menu “Product Configuration”.

2.	 Make sure that the DHCP Client is switched to “DISABLE” and the DHCP Server Function to 
“ENABLE”

3.	 Click on “Submit” to confirm the settings.

4.	 Toggle to the SIR software and verify, whether the XL2 instruments are connected properly.
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Selecting Standard and Type of Sound Insulation
•	 Start the Sound Insulation Reporter software.

•	 Click on File -> New

•	 Select your requested Standard

•	 Select Airborne, Impact or Facade Sound Insulation.

•	 Select the number of Speaker positions used.

•	 Select Unit.

•	 Define the required Results.

•	 Select the preferred Rating Format. Choose either Dw(C;Ctr) = 41 (-1;-3) dB or   
Dw = 40.5 dB +/- 0.9 dB. 

•	 Confirm with OK.

SOUND INSULATION REPORTER
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Preparing the Measurement

•	 Click on Connect... 1  in the toolbar.
1

	The Sound Insulation Reporter software detects all available XL2 Sound Level Meters connected 
in the COM-port mode.

•	 Verify the connected XL2 Sound Level Meters.

	Status confirms Valid Licence for the connected XL2s with the options Extended Acoustic Pack, 
Remote Measurement Option and Sound Insulation Option or Sound Insulation Reporter 365 
enabled. Using Sound Insulation Reporter 365 requires an active internet connection.
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•	 Tick Simultaneous measurement in source and receiving room as applicable. This selection 
is dedicated for parallel measurements in source and receiving room with one or more instru-
ments. Assign at least one device to the source room and another one to the receiving room. 
This is applicable for airborne or facade sound insulation measurements.
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•	 The PA3 Power Amplifier for the Dodecahedron Speaker DS3 may also be remotely controlled. 
For this purpose, you may connect the PA3 using a LAN cable to the

	- LAN network for a fixed permanent installation

	- Wi-Fi access point for an onsite temporarily installation

•	 Select Use for Spectrum and Reverberation Time measurements

•	 Click on Refresh

	The IP number of the connected PA3 Power Amplifier is displayed (Connected to xx.xxx.x.xx)

•	 Verify the firewall settings on the connected computer; the access to the displayed IP address 
has to be enabled. In case of the message A critical error occurred is shown at the start of 
your next measurement, then disable the firewall for evaluation shortly.

•	 Confirm your settings with OK.

SOUND INSULATION REPORTER
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Sound Spectrum Measurement
•	 Select the measurement in the drop-down menu, e.g. L1-1, L2-1 for simultaneous measure-

ment of sending and receiving room at speaker position 1.

•	 Press Start in the toolbar.
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1 2

	The remote measurement is started. The actual levels are visualized in the software.

1 Sending Room
Serial number of XL2 assigned to sending room and measurement timer.

2 Receiving Room
Serial number of XL2 assigned to receiving room and measurement timer.

•	 The measurement stops automatically after the preset measurement duration.

•	 Move the microphone position and continue with the next measurement.

•	 Follow the same procedure for the second speaker position and the background noise record-
ing.
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Reverberation Time Measurement
•	 Select T2 for the reverberation time measurement in the toolbar.

•	 Press Start in the toolbar.

•	 Activate the dodecahedron speaker with pink noise or the impulse sound source.

	The XL2 measures the reverberation time. The averaged test result is visualized in the software.

•	 Press Stop in the toolbar.

	The reverberation time measurement is completed.

•	 Move the microphone position and continue with the next measurement. 

•	 Verify the measurement data and delete any false readings from the Measurements list on the 
right.
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Measurement Report
•	 Select View -> Calculations in the menu.

•	 Verify the individual averaged results.
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•	 Select the View -> Results. 

		The sound insulation data and chart are displayed.

•	 Complete the header data with information about client, object, description, partition area and 
room volumes.

•	 Print the sound insulation report.

	Congratulations, your report is completed! 
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7.	 Re-Use and Edit Data

This chapter describes how measurement data may be imported from other projects and how rever-
beration time data may be duplicated and edited.

Add Data from other Projects
Measurement data may be imported from other projects. This allows to re-use the same background 
noise or reverberation time data of the receiving room for multiple projects; e.g. in case the sound 
insulation from rooms left, right or on top of the receiving room shall be evaluated. Also, data re-
corded directly by the Sound Insulation Reporter software by automated measurements may be 
re-used in this manner.

How to import data from another project?

•	 Select File -> Import -> Measurements from Project…

•	 Select your existing Sound Insulation Reporter Project

	All data of the selected project is imported into the existing project.

•	 You may delete any non-required data

•	 Verify the assignment of the imported data

Edit reverberation time data
Reverberation time data sets may be incomplete, e.g. due to insufficient sound energy in the room 
in lower frequency bands. The Sound Insulation Reporter software allows to duplicate a reverbera-
tion time data sets and edit them for evaluation. The original data set remains available.

How to duplicate and edit reverberation time data?

•	 Select the Measurements View

•	 Click with the right-mouse-button on a reverberation time measurement

•	 Select Duplication to Edit…; the Edit Measurement panel opens

•	 Edit name and data values

•	 Press OK to store your changes

•	 Delete the original data set or disable it in the Calculations View from the average calculation 

SOUND INSULATION REPORTER

USER MANUAL



www.nti-audio.com Page 33 / 97

8.	 Main Menu

Toolbar

1 2 3 4 5 6 7 8 9 10 11 12 14 1513

1 New Project
A project contains the measurement data of one partition. The airborne or impact sound insula-
tion of a new project is calculated in accordance with the selected standard.

•	 Select the number of Speaker positions used for the measurements with the XL2 Sound 
Level Meter.

•	 Select Unit.

•	 Select the Results required.

•	 Select the preferred Rating Format for the standards BB93, DIN4109, ISO 16283, ISO 
10140 and SIA 181. By default is the single number rating provided in 1.0 dB steps in all 
standards, e.g. Dw(C;Ctr) = 41 (-1;-3) dB. Alternatively, the standards BB93, DIN4109, ISO 
16283, ISO 10140 and SIA 181 may show the single number rating in 0.1 dB steps with 
measurement uncertainty, e.g. 40.5 dB +/- 0.9 dB. 

•	 Confirm the settings with OK.

2 Open Project File
Select an existing project file *.xlba.

3 Save Project File
Save the actual sound insulation data as project file *.xlba.

4 Print Preview
The sound insulation reports for the selected results are displayed.

5 Print
The sound insulation reports for the selected results are printed.

6 Import
Select the folder containing the original XL2 measurement data *.txt and *.xl2 files and con-
firm with “Select folder”. All measurement files within the selected folder are imported into the 
software. Any recorded data with A- or C-weighting is automatically corrected to Z-weighting 
(=no weighting).
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7 Export to Excel
Exports all measurement data and results into MS Excel.

8 Measurements View
The original XL2 measurement data is visualized in the frequency range from 50 Hz to 5 kHz. 
By default, all measurement data, as well as the speaker position for the sound insulation 
calculation, are automatically assigned to the corresponding sending or receiving room. Alter-
natively, the data can be assigned manually.

9 Calculations View
Displays the average of the

•	 sending room level for each speaker position

•	 receiving room level for each speaker position

•	 background noise level

•	 reverberation time

10 Results View
Displays the following sound insulation results based on the selected result type:

•	 Table from 50 Hz - 5 kHz

•	 Standardized chart from 50 Hz - 5 kHz

•	 Single number sound insulation rating

•	 Rating corrections Cxx
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11 Settings

General •	 Select the number of Speaker positions used for the measurements.

•	 Select Unit.

•	 Select the Results required.
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11 Settings

Mapping Sound insulation measurements require the recording of multiple noise spectras 
in the sending and the receiving rooms. The XL2 with firmware V4.03 or higher 
simplifies the data handling of these measurements by recording each data set 
with a dedicated location mapping, such as “L1-1” for a measurement carried 
out in the sending room with speaker position 1. Storing the measurement data 
with this mapping on the XL2 supports the automated data assigning to the 
corresponding room and speaker position during the data import into the Sound 
Insulation Reporter software.

•	 Click on Export...; this generates the text file savenames.txt

•	 Load the txt-file “savenames.txt” with the various mappings, like “L1-1”, “L1-
2”... onto the SD card of the XL2. 

•	 Copy this file onto the root directory of the XL2 memory card

•	 Select the memory menu on the XL2 and set Autosave: Off

	Each measurement can be manually stored on the XL2 with one of the pre-
defined mappings. 
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11 Settings

Charts
Spectrum Set the Y-axis scaling for measurements and calculations 

view

Reverberation Time Set the Y-axis scaling for measurements and calculations 
view

Results Set the Y-axis scaling for the chart in results view. The 
default span is 60 dB.
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11 Settings

Report •	 Load your company logo for the printed measurement reports

•	 Align title to the left offers more space for your company logo in the report 
header.

•	 Show Appendix enables an appendix field in the report header; this allows 
adding the report with an appendix number to a longer report.

•	 Hide equipment offers more space for the description in the report.

•	 Hide area of common partition is e.g. used in applications without a com-
mon partition.

•	 Hide source room volume offers also more space for the description in the 
report. 
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•	 Set the Name of the test institute, e.g. your company name

•	 Load your Signature for the printed measurement reports

The recommended maximum size for the imported picture is

•	 Logo: 120 x 30 px, 96 dpi

•	 Signature: 350 x 70 px, 96 dpi
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12 Connect
•	 Select the SLM measurement duration (default = 15 seconds). 

The standard ISO 16283 lists a minimum measurement duration for fixed microphone 
positions of

	- 6 seconds for the frequency range 100 Hz - 5000 Hz

	- 15 seconds for the frequency range 50 Hz - 5000 Hz

•	 Select the Reverberation Time input range (default = High)

•	 Select the Reverberation Time method (default = T20)

•	 Click Refresh to detect the connected XL2 Sound Level Meters.

•	 Simultaneous measurement in source and receiving room 
This selection is dedicated for parallel measurements in source and receiving room with 
one or more instruments. Assign at least one device to the source room and another one 
to the receiving room for airborne or facade sound insulation measurements. The Sound 
Insulation Reporter software may operate multiple instruments at the same time. 
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12 •	 Measuring with one or more instruments in the same room

	- Do not select Simultaneous measurement in source and receiving room

	- Assign the applicable instruments to Any 

•	 Microphone 
Arrows next to the serial number indicate, that the assigned microphone correction will 
be applied. This may be set at File -> Preferences... -> Microphone Corrections. 

•	 The Status column list one of the following information

	- Valid Licence

	- Upgrade required

	- Unassigned Device (XL2 will not be used to measure)

	- Not Connected (the XL2 was previously connected and assigned to the specified 
room; if you forgot to connect it, then place it in the assigned room, connect it and 
click Refresh; if you don’t want to use this device anymore, then ignore this message)

PA3 Power Amplifier
•	 Tick this setting to remotely control the PA3 power amplifier for the Spectrum and Re-

verberation Time measurements, which needs to be connected via LAN or Wi-Fi to the 
network. 

•	 Set the Reverberation Time measurement cycle duration from 1 to 10 seconds.

13 Start Remote Measurement
Start here the selected measurement. The measurement will automatically stop after the pre-
set measurement duration.

14 Select Measurement
Select one of the following measurements at airborne sound insulation testing

•	 L1-1, L2-1 (sending & receiving room simultaneously @ speaker position 1)

•	 L1-2, L2-2 (sending & receiving room simultaneously @ speaker position 2)

•	 B2 (background noise)

•	 T2 (reverberation time)

15 Stop Remote Measurement
Stop here the selected measurement prior the automated stop according the preset measure-
ment duration.
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Menu
The software offers the following menu functionalities:

File New... A project contains the measurement data of one partition. The air-
borne or impact sound insulation of a new project is calculated in 
accordance with the selected standard.

•	 Select the number of Speaker positions used for the measure-
ments with the XL2 Sound Level Meter.

•	 Select Unit.

•	 Select the Results required.

•	 Select the preferred Rating Format for the standards BB93, 
DIN4109, ISO 16283, ISO 10140 and SIA 181. By default is the 
single number rating provided in 1.0 dB steps in all standards, 
e.g. Dw(C;Ctr) = 41 (-1;-3) dB. Alternatively, the standards BB93, 
DIN4109, ISO 16283, ISO 10140 and SIA 181 may show the 
single number rating in 0.1 dB steps with measurement uncer-
tainty, e.g. 40.5 dB +/- 0.9 dB. 

•	 Confirm the settings with OK.

Open... Select an existing project file *.xlba.

Save Save the actual sound insulation data as project file *.xlba.

Save as... Save the project with selectable name and path.

Print Preview The sound insulation reports for the selected results are displayed.

Print The sound insulation reports for the selected results are printed.

Import
Folder... Select a folder in order to import all measurement 

data stored in this folder

File... Select a single measurement data file *.xl2

Airborne  
Difference ...

Applicable for standard DIN 4109 only. Select an air-
borne sound insulation project based on DIN 4109.

Any recorded data with A- or C-weighting is automatically corrected 
to Z-weighting (=no weighting).
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Export to  
Excel...

Export all measurement data and results into MS Excel.

File Preferences... General

The Sound Insulation Reporter software is available in Chinese, Eng-
lish and German language. Additionally, the reporting is offered in the 
languages Czech and Italian. The default setting uses the language of 
the operating system installed on your computer. Select the language 
as follows:

•	 Select File in the menu.

•	 Select Preferences...

•	 Select the language. Changing the language will require a restart 
of the software. 

•	 Confirm the settings with OK.

	The software closes and restarts with the selected language.

Microphone Corrections

Enter any applicable frequency response correction for the used mea-
surement microphones here with type and serial number. The unit is 
[dB]. This correction is automatically applied at the import of any data 
recorded with this microphone or any remote measurements per-
formed. Sound Insulation Reporter calculates (measurement result 
+ correction) for each frequency band and presents the result in the 
chart. The data set requires to list the same type and serial number 
in the header data in order to detect the microphone type and serial 
number.

Note: the correction is not applied on any existing projects.

Recent Select a recently-opened project.

Exit Close the software.

Edit Cut Cut the text from any text box.

Copy Copy the data selected in the right-hand Measurements, Calcula-
tions or Results box.

Paste Paste the copied text into any text box.
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Delete Delete the data selected in the right-hand selection box in Measure-
ments.

Select All Select all data in the right-hand Measurements box (applicable in 
Measurements View only).

Deselect All Deselect all earlier selected data in the right-hand Measurements 
box (applicable in Measurements View only).

View Measurements Select the Measurements View.

Calculations Select the Calculations View.

Results Select the Results View.

Settings Opens the Project Settings window.

Measure Connect... Opens the window Connect

Start Starts the selected measurement.

Stop Stops the selected measurement.

Measurements 
e.g. L1-1/L2-1

Select the measurement.

Help Online Help Link to download the user manual in PDF form

Check for  
Updates...

Checks for available updates of the Sound Insulation Reporter soft-
ware.

About List’s version and copyright details of the software.
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9.	 Analysis and Reporting Views

The Sound Insulation Reporter software offers three views for fast data analysis and straight-forward 
reporting in accordance with the standard.

1 2 3

1 Measurements View

2 Calculations View

3 Results View
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Measurements View

By default, all measurement data are automatically assigned to the corresponding sending or receiv-
ing room, as well as the speaker position for the sound insulation calculation. Alternatively, the data 
can be assigned manually.

7

2

9 10 118

1

12

3

4

5

6

13

1 Details
Header data of the sound insulation report. The partition area and volume parameters are used 
for the sound insulation calculation.

2 Spectrum Measurements Chart
The original XL2 measurement data is visualized in the frequency range from 50 Hz to 5 kHz. 

3 Y-Axis of Spectrum Measurements Chart
Set the Y-axis in Settings -> Charts
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4 X-Axis of Spectrum Measurements Chart
The X-axis is fixed to 50 Hz - 5 kHz.

5 Reverberation Time Measurements Chart
The original XL2 measurement data is visualized in the frequency range from 50 Hz to 5 kHz. 

6 Y-Axis of Reverberation Time Measurements Chart
Set the Y-axis in Settings -> Charts

7 Guideline Bar
Additional information about displayed measurement data is listed here.

8 X-Axis of Reverberation Time Measurements Chart
The X-axis is fixed to 50 Hz - 5 kHz.

9 Standard
Selected standard for the sound insulation calculation and reporting.

10 Speaker Positions
Reads the number of set speaker positions.

11 Single Number Sound Insulation
Reads the single number results. Select the calculated results in Settings -> General

12 Measurements List with Mappings
List all the imported XL2 measurement data files with the automatically-assigned mapping. 
The mapping may be assigned manually to sending room or receiving room and the individual 
speaker positions:

•	 Select the measurement with the mouse

•	 Click on the right mouse button

•	 Select Assign To 

•	 Assign the measurement

13 Image
Click into the image field and load a drawing or picture describing the partition. The recom-
mended maximum size is for

	- A4 Reporting: 340 x 160 px

	- Letter Reporting: 350 x 130 px
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Calculations View

4 6 7 85

1

2

3

9

10
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12

11

13

1 Details
These data are listed in the header of the sound insulation report. The partition area and vol-
ume parameters are used for the sound insulation calculation.

2 Chart
The averaged measurement data for sending room, receiving room and individual speaker 
position is visualized in the frequency range from 50 Hz to 5 kHz. 

3 Y-Axis
Set the Y-axis in Settings -> Charts

4 Guideline Bar
Additional information about displayed measurement data is listed here.

SOUND INSULATION REPORTER

USER MANUAL



www.nti-audio.com Page 50 / 97

5 X-Axis
The X-axis is fixed to 50 Hz - 5 kHz.

6 Standard
Selected standard for the sound insulation calculation and reporting.

7 Speaker Positions
Reads the number of set speaker positions.

8 Single Number Sound Insulation
Reads the single number results. Select the calculated results in Settings -> General

9 Differences
Select Difference D-1 and view the averaged sending room, averaged receiving room and the 
calculated difference for the speaker position 1. Any applicable background noise correction is 
included by default.

10 Average
•	 Averaged data sets for sound insulation calculation. 

•	 Select e.g. Average L1-1 for detailed verifications of the measurement data used for the 
average calculation.

•	 Press ESC on the keyboard to return to the default view with all averaged measurements.

11 Detailed View
Displays all measurement data and the averaged result for the selected parameter.

12 Measurements Selection
Disable any measurement data, which shall not be used for the average calculation.

13 Selected Average Parameter
Select the parameter for detailed analysis.
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Results View

The results view displays the following sound insulation results based on the selected result type:

•	 Table from 50 Hz - 5 kHz

•	 Standardized chart from 50 Hz - 5 kHz

•	 Single number quantity

•	 Spectrum adaption terms C and Ctr

1

4

2

6 7 8

11

3

5

10

9
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1 Details
These data are listed in the header of the sound insulation report. The partition area and room 
volume parameters are used for the sound insulation calculation.

2 Results Table
Sound insulation results in the frequency range from 50 Hz to 5 kHz. 

The fixed background noise correction of 1.3 dB is automatically applied in case the receiving 
room level differs by less than 6 dB from the background noise level, e.g. in accordance with 
ISO 16283. In case this fixed correction is applied, then the applicable frequency bands are 
marked by the symbol ≤ or ≥; see 3 .

3 Information about Background Noise Correction
A fixed background noise correction applied in the table 2  at frequency bands marked by the 
symbol ≤ or ≥.

4 Guideline Bar
Additional information about displayed measurement data is listed here.

5 Results Chart
Sound insulation results spectrum with shifted reference curve in the frequency range from 
50 Hz to 5 kHz.

6 Standard
Selected standard for the sound insulation calculation and reporting.

7 Speaker Positions
Reads the number of set speaker positions.

8 Single Number Sound Insulation
Reads the single number results. Select the calculated results in Settings -> General.

9 Spectrum Adaption Terms
Value, in decibels, to be added to the single-number rating (e.g. R’w) in accordance with ISO 
standards. These take into account different spectra of noise sources; such as pink noise (C) 
and road traffic noise (Ctr).

Application examples

•	 C 
Living Area Noise (talking, music, radio, TV), trains at middle and high speed, highway 
traffic @ speed > 80 km/h, jets in near distance, factories with mainly middle- and high-
frequency noise

•	 Ctr 
traffic noise in cities, trains at low speed, jets in far distance, airplanes, factories with 
mainly low-frequency noise
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10 Single Number Quantity
This is the single number sound insulation result. The single number result equals the level of 
the shifted reference curve at 500 Hz.

Select the preferred Rating Format for the standards BB93, DIN4109, ISO 16283, ISO 10140 
and SIA 181. By default is the single number rating provided in 1.0 dB steps in all standards, 
e.g. Dw(C;Ctr) = 41 (-1;-3) dB. Alternatively, the standards BB93, DIN4109, ISO 16283, ISO 
10140 and SIA 181 may show the single number rating in 0.1 dB steps with measurement 
uncertainty, e.g. 40.5 dB +/- 0.9 dB. 

11 Result Selector Box
Select the required sound insulation result here. The available results are preset in Settings 
-> General.
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10.	 Sound Insulation Report

The software generates automated reports in accordance with the supported standards. Print the 
reports for the selected results.
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11.	 Export Measurement Data

Click on the “Export to Excel ...” button in the menu bar. This exports all measurement data and re-
sults into MS Excel. Alternatively, you may export individual data and charts for user defined analysis 
and reporting as follows:

•	 Select the required result or data set in the right-hand column and click with the right mouse 
key.

•	 Select Copy or Copy values. Copy selects the data with headers - Copy values just the data. 

•	 Alternatively press CTRL+C on the computer keyboard.

•	 Open the application e.g. Microsoft Excel.

•	 Press CTRL+V on the computer keyboard for the data or Paste Special for the chart.

	The selected measurement data is exported.
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12.	 Standard ISO 16283 

Low Frequency Procedure for Rooms < 25 m3
The following applies

•	 First a room volume < 25 m3 has to be entered. Then the measured data may be assigned in 
accordance with the low frequency procedure.

•	 The reverberation time of the 63 Hz octave band is calculated based on linear average of mea-
sured 50 Hz, 63 Hz and 80 Hz frequency bands.

Measurement of Doors
For the measure the sound insulation of doors the following has to be observed:

•	 The area of common partition is the area of the free opening in which the door, including its 
frame, is mounted.

•	 The apparent sound reduction index of a door measurement is correct in case all the sound is 
transmitted through the door area.

•	 A second sound insulation measurement is required in order to check the flanking transmission 
by fitting the door with additional sound insulation. The measured sound insulation is stored as 
reference.

•	 The reference data from the second measurement may be loaded into the project of the door 
under test by selecting File-> Import -> Reference Level R’... 

•	 Compare the sound insulation of the door under test and the reference in the Calculations 
view.

•	 The Results view presents the apparent sound insulation R’ including any applicable correc-
tions.

13.	 Standard DIN 4109

Airborne sound transmission correction at impact insulation assessments
The standard DIN 4109 can be selected at the start of a new project. The functionalities and calcula-
tions are identical to the standard ISO 16283. Additionally, is the German requirement to perform 
an airborne sound transmission correction at impact insulation assessments listed in Appendix A of 
DIN 4109-4:2016.

In case a high airborne sound level is generated by the tapping machine in the sending room, then 
the measured impact noise level in the receiving room can be influenced by the airborne noise trans-
mission through the partition under investigation. Follow these steps to include the correction for 
the airborne sound transmission:

•	 Assess the airborne sound insulation D between the two partitions (create a new project and 
select the standard DIN 4109)

•	 Verify the impact sound insulation without any airborne sound correction.
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•	 Measure the sound pressure level of the tapping machine in the sending room and assign the 
data sets to the sending room L1 in the software.

•	 Select in the menu File-> Import -> Airborne Difference... and choose the project with the 
airborne sound insulation D.

	The project with the airborne sound insulation D is loaded and the correction applied for the im-
pact sound insulation calculation.

•	 Evaluate the effect with or without airborne sound transmission correction by deleting the Air-
borne Difference D in the Measurements view and import this correction again as required. 

Airborne sound transmission testing of doors from apartments to stair cases or corridors
The stair case or corridor is used as sending room. The sending room level is measured by scanning 
the level in front of the door. This measurement method requires a 3 dB correction to default mea-
surements in the room.

Measurement of the airborne sound insulation of external components in the building
The Sound Insulation Reporter software calculates the sound reduction index R’ according to the 
angle used by the loudspeaker to the perpendicular of the test object. One of the following measure-
ments methods may be selected

•	 Element Loudspeaker method

	- flush-mounted microphone close to the test surface

	- the sound reduction index R’ is calculated according to DIN 4109-4 (formula B.2) 

		  R‘d = L1 – L2 +10 * log (S*T /(0.16 * V) * cos d) 

•	 Global Loudspeaker method

	- 	microphone mounted 2 m in front of building

	- the sound reduction index R’ is calculated according to DIN 4109-4 (formula B.3)

		  R‘d = L’1 – L2 +10 * log (S*T /(0.16 * V) * cos d) + 3 dB

	 with

	 L1… mean sound pressure level on the surface of the test object [dB]

	 L’1… mean sound pressure level at 2 m in front of the test object [dB] 

	 L2… mean sound pressure level in the receiving room [dB]

	 S … area of the test item

	 T ... reverberation time

	 V… volume of the reception room

	 d ... angle of the loudspeaker to the vertical perpendicular of the test object
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14.	 Standard ISO 10140
ISO 10140 specifies a laboratory method for measuring the 

•	 airborne sound insulation of building products, such as walls, floors, doors, windows, shutters, 
façade elements or façades

•	 impact sound insulation of floor assemblies

Flanking Transmission at Airborne Sound Insulation
In laboratories complying with ISO 10140-5, ensure that the sound transmitted by indirect paths is 
negligible compared with the sound transmitted through the test element. A preliminary test shall 
be carried out to ensure that sound power transmitted through the surrounding partition is small 
compared with the sound power transmitted through the test element.

•	 Select the applicable test arrangement in the Project Settings

	- Full-size test opening

	- Reduced-size opening (building element)

	- Reduced-size opening (technical element)

•	 Measure the maximum airborne sound insulation of the test stand and store the project data as 
reference.

•	 Install the test element and perform the sound insulation test.

•	 The reference data may be loaded into the project of the test element by selecting File -> Im-
port -> Reference Level …

•	 Compare the sound insulation of the test element and the reference in the Calculations view.

•	 The Results view presents the apparent sound insulation R’ including any applicable correc-
tions.

Floor coverings — Improvement of Impact Sound Insulation
The Sound Insulation Reporter software allows evaluating the weighted reduction in impact sound 
pressure level ΔL. This is the impact sound insulation improvement of a floor under test compared 
to a reference floor. 

•	 Measure the impact sound insulation of the reference floor and save the data in a project.

•	 Open a new impact sound insulation project and activate ΔL as result.

•	 Measure the impact sound insulation of the floor under test.

•	 Select File -> Import -> Reference Level Ln…

•	 Select the reference floor project. Now the reference level Ln is imported and displayed in the 
measurements view.

•	 Switch to the results view and select the result ΔL.

•	 Set the Y-scaling in the Settings-Charts menu as required.

SOUND INSULATION REPORTER

USER MANUAL



www.nti-audio.com Page 59 / 97

15.	 Standard BB93
Building Bulletin 93 (BB93) explains minimum performance standards for the acoustics of school 
buildings in the UK. The latest edition is dated February 2015. The sound insulation is measured and 
reported in accordance with ISO 16283. 

For the purpose of the assessment the mid-frequency reverberation time Tmf may be edited in 
accordance with BB93, which lists the maximum expected reverberation time of the finished and 
unfurnished room. The Tmf is the is the arithmetic average of the reverberation times in the 500 Hz, 
1 kHz and 2 kHz octave bands, or the arithmetic average of the reverberation times in the one-third 
octave bands from 400 Hz to 2.5 kHz. In practice the difference between the measured and listed 
Tmf will be small. This is acceptable in the interests of simplicity and ease of measurement.

16.	 England/Wales: Approved Document E (2003)
Approved Document E provides guidance on the resistance to the passage of sound in domestic 
buildings, in schools and flats. This guidance applies to new buildings, to alterations to pre-existing 
premises and to buildings being converted to flats in the England and Wales. The latest amendment 
has been made in 2015.

It specifies to measure the sound insulation in accordance with the standard series ISO 140.
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17.	 Specifications

Airborne 
Sound Insulation

Impact 
Sound Insulation

Facade  
Sound Insulation

Standards •	 ASTM E336-20

•	 ASTM E413

•	 BB93

•	 DIN 4109

•	 England/Wales:  
Approved Docu-
ment E (2003) 

•	 ASTM E1007

•	 ASTM E989

•	 BB93

•	 DIN 4109

•	 England/Wales:  
Approved Docu-
ment E (2003)

•	 ASTM E966

•	 ASTM E1332 

•	 DIN 4109

•	 GB/T 19889.4 - 2005

•	 ISO 10140:2021

•	 GB/T 19889.7 - 2005 

•	 ISO 10140:2021

•	 GB/T 19889.5 - 2006

•	 ISO 140-4:1998

•	 ISO 16283-1:2014 
incl. Rooms < 25m3

•	 ISO 717-1:2021

•	 ISO 12999-1:2014

•	 NEN 5077:2019

•	 SIA181:2006

•	 SIA181:2020

•	 ISO 140-7:1998

•	 ISO 16283-2:2018 
incl. Rooms < 25m3

•	 ISO 717-2:2020

•	 ISO 12999-1:2014

•	 NEN 5077:2019 

•	 SIA181:2006

•	 SIA181:2020

•	 ISO 140-5:1998 

•	 ISO 16283-3:2016 
incl. Rooms < 25m3

•	 ISO 717-1:2021

•	 ISO 12999-1:2014

•	 NEN 5077:2019 

•	 SIA181:2006

•	 SIA181:2020

Results (ASTM) •	 NR, NIC

•	 NNR, NNIC

•	 ATL, ASTC

•	 ISPL, ISR

•	 RTNISPL, AIIC

•	 ANISPL, NISR

•	 OINR, OINIC

•	 AOITL, AOITC

Sound Sources 
(ISO)

•	 Speaker •	 Tapping Machine

•	 Rubber Ball

•	 Speaker

•	 Road Traffic

•	 Railway Traffice

•	 Aircraft Traffic

Results (ISO) •	 Dw

•	 Dn,w

•	 DnT,w

•	 R’w

•	 Spectrum adaption 
terms C, Ctr

•	 L’n,w

•	 L’nT,w

•	 Spectrum adaption 
terms CI

•	 D,w

•	 R’45°,w

•	 Dxx,2m,w

•	 Dxx,2m,n,w

•	 Dxx,2m,nT,w

•	 Spectrum adaption 
terms C, Ctr

Measurement  
Uncertainty

In situ standard deviation in accordance with ISO 12999-1 for the standards 
BB93, DIN 4109, ISO 16283, ISO 10140, NEN 5077 and SIA 181
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Reporting •	 PDF via PDF-printer 

•	 XPS

•	 Copy/paste data into User Reports

Languages •	 English, German and Chinese

•	 Report: Czech, Dutch, French, Italian, Korean, Swedish

Operating  
System

•	 Windows Vista, 7, 8.x and 10

Licensing •	 Install Sound Insulation Option into XL2 or activate Sound Insulation 
Reporter 365 online at my.nti-audio.com; this enables the import of 
measurement data into the Sound Insulation Reporter software

•	 Sound Insulation Reporter can be installed on multiple computers

XL2 
Requirements

•	 Installed optional Extended Acoustic Pack to measure the  
reverberation time in 1/3 octave band resolution.

•	 Installed Remote Measurement Option to measure sending and receiv-
ing room simultaneously with two connected instruments controlled 
directly within the Sound Insulation Reporter software.

Order  
Information

•	 Sound Insulation Option 
NTi Audio # 600 000 432

•	 Sound Insulation Reporter 365 
(annual subscription service) 
NTi Audio # 600 000 433

All information is subject to change without notice.
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18.	 Revision-History

Release V1.40, Nov 2022
•	 XL3 Acoustic Analyzer

	- Import measurement data

	- Import sound insulation projects (File -> Sound Insulation on XL3…)

•	 General

	- Import and drag&drop of zip files

	- Rounding of spectrum adaption terms in accordance with ISO 717

•	 Reporting

	- Language Latvian

Release V1.36, Nov 2021
•	 Dutch standard NEN 5077:2019

•	 Swiss standard SIA181:2020

•	 Updated ASTM E336 to latest release 2020

•	 Façade Sound Insulation

	- 	Global and Element Loudspeaker method

	- 	Signal sources Road Traffic, Railway Traffic and Aircraft Traffic

•	 ISO 16283

	- Airborne sound insulation of doors

	- Rating result for impact source “Rubber Ball”

	- Low frequency procedure for rooms < 25 m3 calculates reverberation time as linear average 
of 50 Hz, 63 Hz and 80 Hz frequency bands

•	 ISO 717

	- Spectrum adaption terms for rating format 0.1 dB calculated according to ISO 717-1:2020 

•	 ISO 10140

	- Impact source “Rubber Ball”

	- Include flanking transmission

•	 DIN 4109

	- Calculate Sound Insulation Index R’ for “Global” measurement method

•	 Remote measurement

	- Support spectrum measurements without optional Extended Acoustic Pack installed

•	 Reporting

	- Values at the limit of measurement are marked by ≤ or ≥

	- Languages Dutch, French, Korean, Swedish

	- Optimized chart and scaling

	- Increased maximum room volume

SOUND INSULATION REPORTER

USER MANUAL



www.nti-audio.com Page 63 / 97

Release V1.30, Dec 2019
•	 Enable copy and edit of Reverberation Time data

•	 Import measurement data from other projects (re-use live measurements for different stan-
dards)

•	 Impact sound pressure level reduction ΔLw for ISO 10140

•	 Standard BB93, Acoustic Design of Schools

•	 Updated measurement uncertainty according to ISO12999-1:2014 for DIN4109, ISO 16283,  
ISO 10140 and SIA 181

•	 Standard DIN 4109

	- Door scanning method for airborne sound insulation

	- Simultaneous measurement of send and receive room for impact sound insulation

	- List frequency bands with airborne noise correction for impact sound insulation measure-
ments

	- Angle of incidence for façade sound insulation

•	 Remote measurement

	- Extended measurement duration settings for Noise and Reverberation Time

	- Selectable T20 or T30 reverberation time measurement

•	 Reporting

	- Appendix number in header

	- More space for long descriptions

	- Extended configurations for flexible reporting 

	- Languages Italian and Czech

	- Today button on calendar date

Release V1.28
•	 Sound Insulation in accordance with DIN 4109 including airborne noise correction at impact 

noise measurement

•	 Laboratory measurement of sound insulation of building elements in accordance with ISO 
10140

•	 Measurement and analysis of impact sound insulation with rubber ball in accordance with ISO 
16283-2

•	 Flexible range setting for remote measurement of reverberation time

•	 Apply frequency response correction data for measurement microphone 

•	 Automated test signal activation with remotely controlled PA3 Power Amplifier for Dodecahe-
dron Speaker DS3

•	 Extended reporting flexibilities, e.g. hide sending room volume

Release V1.27
•	 Export to Excel

•	 Sound Insulation in accordance with SIA 181:2006

•	 Low-frequency procedure in accordance with ISO 16283

•	 Measurement uncertainty listed as single-number results in accordance with ISO 717
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•	 Remote measurement in the same room with one or multiple instruments

•	 Extended reporting flexibilities, e.g. picture added

Release V1.26
•	 Remote measurement in sending and receiving room at the same time

•	 Façade Sound Insulation in accordance with ISO16283-3, ISO 140-5 and ASTM E966

•	 Sound Insulation in accordance with GB/T 19889 

•	 Extended reporting flexibilities

Release V1.25
•	 Remote measurement in sending and receiving room at the same time

•	 Façade Sound Insulation in accordance with ISO16283-3 and ASTM E966

•	 Extended reporting flexibilities
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19. End-User Licence Agreement

This End-User License Agreement (“EULA”) is a legal agreement between you (either an individual 
or a single entity) and NTi Audio AG (“NTi Audio”). By installing or using the NTi Audio software, con-
tent or documentation (collectively the “NTi Audio software”) accompanying this EULA, you accept 
these terms and are consequently bound to them. If you do not agree to the terms of this EULA, do 
not install or use the NTi Audio software.

The NTi Audio software is licensed not sold, to you by NTi Audio for use only under the terms of 
this license agreement. This EULA only gives you some rights to use the software. You may use the 
software only as expressly permitted in this EULA.

This EULA also applies for all upgrades or updates to the NTi Audio software (if any), supplements, 
internet-based services, and support services for this NTi Audio software, unless other terms ac-
company those items. If so, those terms will govern.

License Uses and Restrictions
A. Software Installation: Subject to the terms and conditions of this license agreement, you are 
granted a limited, non-exclusive license to use and run the NTi Audio software. Data transfer from 
an NTi Audio test instrument to the NTi Audio software may be restricted, i.e. only enabled if the 
corresponding license is installed on the analyzer. 

B. No Reverse Engineering: You may not and you agree not to, or to enable others to, copy (except 
as expressly permitted by this license agreement or by the usage rules if they are applicable to you), 
publish, distribute, decompile, reverse engineer, disassemble, attempt to derive the source code of, 
decrypt, modify, or create derivative works of the NTi Audio software or any services provided by 
the NTi Audio software, or any part thereof.

C. Termination: This license is effective until terminated. Your rights under this license agreement 
will terminate automatically or otherwise cease to be effective without notice from NTi Audio if you 
fail to comply with any term(s) of this license agreement. Upon the termination of this license, you 
must cease all use of the NTi Audio software and destroy all copies, full or partial, of the NTi Audio 
software.

Services
The NTi Audio software may enable access to NTi Audio and third-party services and web sites (col-
lectively and individually, “NTi Audio services”). Such NTi Audio services may not be available in all 
languages or in all countries. Use of these NTi Audio services requires internet access and use of 
certain NTi Audio services may requires an NTi Audio ID, may require you to accept additional terms 
and may be subject to additional fees. By using this software in connection with an NTi Audio ID or 
other NTi Audio account, you agree to the applicable terms of service for that account.

Disclaimer
A. NTi Audio and all our affiliates do not give any warranty, guarantee or conditions for this software, 
i.e. you bear the sole risk of using it. This limitation applies to anything related to this software, in-
cluding breach of contract, warranty, guarantee or condition, strict liability, negligence or other tort to 
the extent permitted by applicable law. It also applies if NTi Audio knew or should have known about 
the possibility of the damages.	
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B. The NTi Audio software and services are provided “as-is”, i.e. with all faults. You bear the sole risk 
of using it. NTi Audio gives no express warranties, guarantees or conditions. NTi Audio excludes the 
implied warranties of merchantability, fitness for a particular purpose and non-infringement.

C. You acknowledge that the NTi Audio software and services are not intended or suitable for use 
in situations or environments where the failure or time delays of, or errors or inaccuracies in the 
content, data or information provided by the NTi Audio software or services could lead to death, per-
sonal injury, or severe physical or environmental damage, including without limitation the operation 
of nuclear facilities, aircraft navigation or communication systems, air traffic control, life support or 
weapons systems.

D. No oral or written information or advice given by NTi Audio or an NTi Audio authorized representa-
tive shall create a warranty. Should the NTi Audio software or services prove defective, you assume 
the entire costs of all necessary servicing, repair or correction.

E. In no event shall NTi Audio be liable for personal injury, or any incidental, special, indirect or conse-
quential damages whatsoever, including, without limitation, damages for loss of profits, loss of data 
or information, business interruption or any other commercial damages or losses, arising out of or 
related to your use or inability to use the NTi Audio software or services or any third party software 
or applications in conjunction with the NTi Audio software or services, however caused, regardless 
of the theory of liability (contract, tort or otherwise) and even if NTi Audio has been advised of the 
possibility of such damages. In no event shall NTi Audio’s total liability to you for all damages exceed 
the amount of ten US dollars (USD 10.00). The foregoing limitations will apply even if the above 
stated remedy fails of its essential purpose.

Separate Provisions
If any provision of this EULA shall be held to be invalid, illegal or unenforceable, the validity, legality 
and enforceability of the remaining provisions shall in no way be affected or impaired thereby.

Privacy
At all times your information will be treated in accordance with NTi Audio’s privacy poli-
cy, which is incorporated by reference into this license agreement and can be viewed at  
www.nti-audio.com/privacy-statement.

Controlling Law
This license agreement will be governed and construed in accordance with the laws of Liechten-
stein, Europe, excluding its conflict of law principles. No amendment to or modification of this EULA 
will be binding unless in writing and signed by NTi Audio. The English version of this EULA shall 
govern, to the extent not prohibited by local law in your jurisdiction.
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20.	 Appendix: Sound Insulation Measurement

This application note describes how to measure sound insulation. This includes airborne and impact 
sound insulation between two rooms and the airborne sound insulation of façades using sound 
pressure measurements. All measurements are performed by the XL2 Sound Level Meter and 
documented using the Sound Insulation Reporter software in accordance with the standard series  
ISO 16283 and ASTM.

The sound insulation is calculated by combining multiple sound pressure level and reverberation 
time measurements. The measured frequency range is typically from 50 Hz to 5 kHz. The measured 
airborne sound insulation is frequency-dependent but can be converted into a single number, the 
sound reduction index, to characterize the acoustic performance.

This application note applies to rooms with a volume betwee 25 m3 and 250 m3. Special methods 
apply to smaller rooms. 
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1. Getting Ready

Instrument Configuration
The sound level meter shall meet the requirements of a class 1 instrument in accordance with the 
IEC 61672-1 standard. The recommended configuration consists of

•	 XL2 Sound Level Meter or  
XL2-TA Sound Level Meter for legally traceable measurements  
(=XL2 with Type Approval Option installed)

•	 Optional Extended Acoustic Pack installed in XL2 
(required for reverberation time measurement in 1/3 octave resolution

•	 XL2 Sound Insulation Option (permanently installed) or Sound Insulation Reporter 365 (annual 
subscription service)

•	 M2230 Measurement Microphone

•	 ASD Cable, 5 m

•	 NTi Audio Class 1 Sound Calibrator

•	 Lightweight Microphone Tripod

•	 DS3 Dodecahedron Speaker

•	 Tripod for DS3 Dodecahedron Speaker

•	 PA3 Power Amplifier

•	 Tapping Machine TM3

•	 Computer/Tablet with Sound Insulation Reporter Software

Calibration
At the beginning and at the end of each measurement day, the entire sound pressure level measure-
ment system shall be checked with the NTi Audio Class 1 Sound Calibrator. This calibrator meets the 
class 1 requirements specified in the standard IEC 60942. 

Notes: 

•	 The sound pressure level measuring system shall be calibrated at intervals not exceeding two 
years.

•	 Wear hearing protection for all measurements.
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2. Airborne Sound Insulation between two Rooms

Measuring the airborne sound insulation between two room in a building requires the following 
measurements:

•	 Sound pressure level in the sending room

•	 Sound pressure level in the receiving room

•	 Background noise level in the receiving room

•	 Reverberation time in the receiving room

The basic concept of sound insulation measurements is to play a pink noise test signal by the Do-
decahedron Speaker DS3 in the sending room. This generates a diffuse sound field in the room. The 
generated sound is transmitted through the common partition into the receiving room, where also a 
diffuse sound field throughout the room is assumed. 

First the sound pressure level spectrum is measured in the sending room at multiple microphone 
positions and averaged. The same is repeated for the receiving room - any disturbing background 
noise is deducted. 

The difference indicates the insulation for the first speaker position. The same procedure is repeated 
for a second speaker position. Additional reverberation time measurements are carried out in the 
receiving room for corrections - e.g. the receiving room level is higher at very reverberant rooms.
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2.1 Getting Started

Room Selection
Airborne sound insulation is measured between two rooms. One room is chosen as the sending 
room and the other one is chosen as the receiving room. In case the volumes of the two rooms 
differ, then the smaller room shall be used as the receiving room. If one of the rooms is box-shaped 
and the other has a more complicated geometry, the box-shaped room shall be used as the receiv-
ing room.

Sending Room Receiving Room

L1 L2

Selecting Sending Room and Receiving Room
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Speaker Position
•	 Position the Dodecahedron Speaker DS3 in the sending room. 

•	 The measurements have to be carried out with at least two different speaker positions.

•	 Choose speaker position 1 at least 0.5 m from any room boundary and at least 1.0 m from the 
separating partition. Position 2 shall be similarly chosen, plus be in a different plane relative to 
the room boundaries, and with a minimum 1.4 m distance to position 1. In case the separation 
partition is a floor and the speaker is in the upper room, then the Dodecahedron Speaker DS3 
has to be at least 1 m above the floor. The distances are measured from the center of the indi-
vidual driver unit of the Dodecahedron Speaker DS3 closest to the boundary or other speaker 
position.

Sending Room Receiving Room

Source Pos. 1
L1 L2

min. 
0.5 m

Source Pos. 2

min. 1.4 m

min. 1.0 m

Positions of the test signal source for the sound level measurements

Test Signal Level
•	 Reduce level setting on PA3 Power Amplifier to minimum.

•	 Power on PA3 Power Amplifier.

•	 Select the signal source “EQ Pink” for a flat acoustic response in the source room. Go for 
“Pink” in case a higher level is required.

•	 Press “Signal ON” and increase the level until it is minimum of 6 dB – better 10 dB - higher in 
the receiving room than the background noise (in each frequency band from 50 Hz to 5000 Hz). 
In case this is not possible, then the Sound Insulation Reporter software will automatically apply 
corrections in accordance with the standard. 
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2.2 Background Noise Level in Receiving Room

Preparation
•	 Select the RTA page in the SLMeter function on the XL2 

Sound Level Meter.

•	 Select 1/3 octave measurement resolution.

•	 It’s recommended to vacate the room during the measure-
ment so that any noise generated by the operator will not 
affect the measurement.

Background Noise Spectrum in 
the Receiving Room

Measurement
•	 Measure the background noise LZeq in the receiving room for 15 seconds. In case the back-

ground noise is not steady and continuous, then a longer measurement period shall be applied, 
e.g. 30 seconds.

•	 Store the individual readings on the XL2.

Sending Room Receiving Room

Mic Position

Measure the Background Noise Level Lb in the Receiving Room
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2.3 Sound Pressure Levels at speaker position 1

Preparation
Define five microphone positions in the sending and receiv-
ing room, distributed within the maximum permitted space 
throughout each room. The positions shall be in a different plane 
relative to the room boundaries and shall not form a regular 
grid. For example, mark the positions on the floor with a tape. 
The following minimum distances apply:

•	 0.7 m between microphone positions

•	 0.5 m from any room boundary

•	 1.0 m between any microphone position and the speaker

It’s recommended to vacate the room during the level measure-
ment as the operator introduces additional absorption.

Noise Spectrum in the Sending Room

Measurements in Sending & Receiving Room
•	 Measure the sound level spectrum LZeq in the sending and 

receiving room at each position for a measurement period 
of 15 seconds.

•	 Store the individual readings on the XL2.

Noise Spectrum in the Receiving Room

Sending Room Receiving Room

Source Pos. 1 L1 L2

Mic Pos. 3

Mic Pos. 5

Mic Pos. 1

Mic Pos. 4

Mic Pos. 2

Mic Pos. 3

Mic Pos. 5

Mic Pos. 1

Mic Pos. 4

Mic Pos. 2

min. 
0.5 m

min. 
0.7 m

min. 
1.0 m

Measure the Sound Levels in the Sending and Receiving Room with the Speaker at Position 1
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2.4 Sound Pressure Levels at speaker position 2

Move the Dodecahedron Speaker DS3 to source position 2.

Measurements in Sending Room
•	 Measure the sound level spectrum LZeq in the sending 

room at each position for a measurement period of 15 sec-
onds.

•	 Store the individual readings on the XL2.

Noise Spectrum in the Sending Room

Measurements in Receiving Room
•	 Measure the sound level spectrum LZeq in the receiv-

ing room at each position for a measurement period of 15 
seconds.

•	 Store the readings on the XL2.

Noise Spectrum in the Receiving Room

 Sending Room Receiving Room

L1 L2

Source Pos. 2

Mic Pos. 3

Mic Pos. 5

Mic Pos. 1

Mic Pos. 4

Mic Pos. 2

Mic Pos. 3

Mic Pos. 5

Mic Pos. 1

Mic Pos. 4

Mic Pos. 2

Measure the Sound Levels in the Sending and Receiving Room with the Speaker at Position 2
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2.5 Reverberation Time in Receiving Room

Preparation
•	 Move the Dodecahedron Speaker DS3 to the receiving 

room.

•	 Select three microphone positions in the receiving room.

•	 Select the RT60 measurement function on the XL2 Sound 
Level Meter.

•	 Select the 1/3 octave resolution on the XL2.

Reverberation Time T

Measurement
•	 Start the measurement on the XL2.

•	 Start / stop the test signal. 
Guideline: Set the on/off cycle time for the signal longer than the expected reverberation time.

•	 Measure at least two decays per position - better three decays.

•	 Stop the measurement on the XL2.

•	 Store the readings on the XL2.

Sending Room Receiving Room

Source

Mic Pos. 3

Mic Pos. 1

Mic Pos. 2

L1 L2

Measure the Reverberation Time T in the Receiving Room
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2.6 Data Analysis and Reporting

Verify and document all readings by using the Sound Insulation Reporter software. This is a PC-Soft-
ware dedicated for building acoustics professionals. Load all measurement records into the software 
and generate the sound insulation report. The software calculates the weighted ratings based on the 
reference curve shifting method in accordance with the ISO 717-1 standard.

Calculation formulas:

•	 D = L1 – L2

•	 Dn = D - 10 log (A / 10)

•	 DnT = D + 10 log (T / 0.5)

•	 R’ = D + 10 log (S / A)

•	 A = 0.16 * V / T

A Equivalent absorption area of the receiving room [m2]

D Level difference between the sending and receiving room [dB]

Dn Normalized level difference [dB] (the level difference D is standardized to the 
equivalent absorption area of 10 m2 in the receiving room)

DnT Standardized level difference [dB] (the level difference D is standardized to the 
0.5 seconds reference value of the reverberation time in the receiving room)

DnT,w Weighted standardized level difference (is the value of the reference curve at 
500 Hz after shifting the reference curve) [dB]

L1 Sound pressure level in the sending room [dB]

L2 Sound pressure level in the receiving room [dB]

R’ Apparent sound reduction index of field measurement [dB]

R’w Weighted apparent sound reduction index [dB] (is the value of the reference 
curve at 500 Hz after shifting the reference curve)

S Partition area between the sending and receiving room [m2]

T Reverberation time in the receiving room [s]

V Volume of the receiving room in [m3]
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3. Impact Sound Insulation

Two different source types can be used for the measurement of the impact sound insulation

•	 Tapping Machine 
used to assess a variety of light, hard impacts such as footsteps from walkers wearing hard-
heeled footwear or dropped objects

•	 Rubber Ball 
used to assess heavy, soft impacts such as from walkers in bare feet or children jumping, as 
well as quantifying absolute values that can be related to human disturbance

Here the measurement with the Tapping Machine is described.

Measuring the impact sound insulation requires the following measurements: 

•	 Background noise level in the receiving room 

•	 Sound pressure level in the receiving room 

•	 Reverberation time in the receiving room

3.1 Getting Started

Room Selection
Typically, the impact sound insulation is measured between two rooms above each other. The Tap-
ping Machine TM3 is positioned in the upper room, the source room. The measurements are per-
formed in the lower room, the receiving room.

Source Position
•	 Position the Tapping Machine TM3 in the sending room. 

•	 The measurements have to be carried out with at least four different source positions. The mini-
mum distance to any wall shall be 0.5 m. In case of floor constructions with beams the tapping 
machine should be placed in an angel of 45° to the direction of the beams.
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3.2 Background Noise Level in Receiving Room

Preparation
•	 Select the RTA page in the SLMeter function on the XL2 

Sound Level Meter.

•	 Select 1/3 octave measurement resolution.

•	 It’s recommended to vacate the room during the measure-
ment so that any noise generated by the operator will not 
affect the measurement.

Background Noise Spectrum in 
the Receiving Room

Measurement
•	 Measure the background noise LZeq in the receiving room for 15 seconds. In case the back-

ground noise is not steady and continuous, then a longer measurement period shall be applied, 
e.g. 30 seconds.

•	 Store the readings on the XL2.

Sending Room

Receiving Room

Mic Position

Measure the Background Noise Level Lb in the Receiving Room - Side View
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3.3 Sound Pressure Level in Receiving Room

Preparation
The Tapping Machine TM3 shall be placed in at least four different positions randomly distributed on 
the floor under test. The hammer connecting line should be at 45° to the direction of any applicable 
beams or ribs in the floor. Each source position shall have a minimum distance of 0.5 m the any 
room boundary.

Define four microphone positions, distributed within the maximum permitted space throughout the 
receiving room. Use at least two microphone positions for each source position. The microphone po-
sitions shall be in a different plane relative to the room boundaries and shall not form a regular grid. 
For example, mark the positions on the floor with a tape. The following minimum distances apply:

•	 0.7 m between microphone positions

•	 0.5 m from any room boundary

•	 1.0 m from the partition being excited by the impact source. 

It’s recommended to vacate the room during the level measurement as the operator introduces ad-
ditional absorption.

Measurements
•	 Measure the sound level spectrum LZeq at each micro-

phone position for a measurement period of 15 seconds. 

•	 Store the individual readings in the XL2 for post calculation 
of the sound insulation.

Noise Spectrum in the Receiving Room
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Source Room

L1

Source Pos. 3

Source Pos. 1

Source Pos. 4

Source Pos. 2

Tapping Machine Positions in Source Room - Top View

Receiving Room

L2

Mic Pos. 3

Mic Pos. 1

Mic Pos. 4

Mic Pos. 2

Measure the Sound Levels in the Receiving Room with Tapping Machine at Source Position 1 - Top View
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3.4 Reverberation Time in Receiving Room

Preparation
•	 Move the Dodecahedron Speaker DS3 to the receiving 

room.

•	 Select three microphone positions in the receiving room.

•	 Select the RT60 measurement function on the XL2 Sound 
Level Meter.

•	 Select the 1/3 octave resolution on the XL2.

Reverberation Time T

Measurement
•	 Start the measurement on the XL2.

•	 Start / stop the test signal. 
Guideline: Set the on/off cycle time for the signal longer than the expected reverberation time.

•	 Measure at least two decays per position - better three decays.

•	 Stop the measurement on the XL2.

•	 Store the readings on the XL2.

Receiving Room

Source

Mic Pos. 3

Mic Pos. 1

Mic Pos. 2

L2

Measure the Reverberation Time T in the Receiving Room
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3.5 Data Analysis and Reporting

Verify and document all readings by using the Sound Insulation Reporter software. This is a PC-Soft-
ware dedicated for building acoustics professionals. Load all measurement records into the software 
and generate the sound insulation report. The software calculates the weighted ratings based on the 
reference curve shifting method in accordance with the ISO 717-2 standard.

Calculation formulas:

•	 L’n = Li + 10 log (A / 10)

•	 L’nT = Li – 10 log (T / 0.5)

•	 A = 0.16 * V / T

A Equivalent absorption area of the receiving room [m2]

Li Impact sound pressure level in the receiving room [dB]

L’n Normalized sound pressure level [dB]

Ln,w Weighted normalized sound pressure level [dB] (is the value of the reference 
curve at 500 Hz after shifting the reference curve)

L’nT Standardized impact sound pressure level [dB]

L’nT,w Weighted standardized impact sound pressure level [dB] (is the value of the 
reference curve at 500 Hz after shifting the reference curve)

T Reverberation time in the receiving room [s]

V Volume of the receiving room in [m3]
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4. Airborne Sound Insulation of Facades 

Two measurement methods are distinguished for the measurement of the airborne sound insulation 
of facades

•	 Element method

	- for sound insulation measurements of façade elements, e.g. windows

	- The purpose of the measurement is to obtain sound reduction index results for comparison 
with laboratory measurements,

•	 Global method

	- provides the real sound level reduction of a facade under test in a given place relative to a 
position 2 m in front of the façade

	- preferred method for sound insulation measurements of whole facades including all flanking 
paths

	- The result cannot be compared with that of laboratory measurements.

Here the global measurement method is described.

Measuring the airborne sound insulation of facades requires the following measurements: 

•	 Background noise level in the receiving room 

•	 Sound pressure level in front of facade 

•	 Sound pressure level in the receiving room 

•	 Reverberation time in the receiving room 
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4.1 Getting Started

Speaker Position
•	 Position the Dodecahedron Speaker DS3 outdoors in front of the facade. The distance D shall 

be at least 5 m.

•	 The angle of sound incidence at the facade shall be 45° +/- 5°. The distance from the loudspeak-
er to the center of the facade under test shall be at least 7 m.

•	 The sending sound pressure level is measured 2 m in front of the facade.

•	 The measurements may be carried out at one or multiple speaker positions. Several speaker 
positions are required at very large rooms or in case the room has two or more outside walls.

Outdoor Sending Area

Receiving Room

Source

L1 L2

mini
mum

 7 
m

45°

Test Signal Level
•	 Start the pink noise test signal at a low level. 

•	 Increase the level until it is minimum of 6 dB – better 10 dB - higher in the receiving room than 
the background noise (in each frequency band from 50 Hz to 5000 Hz). In case this is not pos-
sible, then the Sound Insulation Reporter software will automatically apply corrections in accor-
dance with the standard.
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4.2 Background Noise Level in Receiving Room

Preparation
•	 Select the RTA page in the SLMeter function on the XL2 

Sound Level Meter.

•	 Select 1/3 octave measurement resolution.

•	 It’s recommended to vacate the room during the measure-
ment so that any noise generated by the operator will not 
affect the measurement.

Background Noise Spectrum in 
the Receiving Room

Measurement
•	 Measure the background noise LZeq in the receiving room for 15 seconds. In case the back-

ground noise is not steady and continuous, then a longer measurement period shall be applied, 
e.g. 30 seconds.

•	 Store the readings on the XL2.

Outdoor Area Receiving Room

L1 L2

Mic Position

Measure the Background Noise Level Lb in the Receiving Room - Top View
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4.3 Outdoor Sound Pressure Level in front of Facade

Preparation
The sending sound pressure level is measured outdoor at 2 m (+/- 0.2m) in front of the facade sur-
face center under test. The height of the microphone is 1.5 m above the receiving room floor.

Measurements
•	 Measure the sending sound level spectrum LZeq for a mea-

surement period of 15 seconds.

•	 Store the readings on the XL2.

Noise Spectrum in front of Facade

Outdoor Sending Area

Receiving Room

Source

L1 L2

45°

Mic Pos.

2 m 

Measure the Sound Level in the Outdoor Sending Area - Side View

SOUND INSULATION REPORTER

USER MANUAL



www.nti-audio.com Page 87 / 97

4.4 Sound Pressure Level in Receiving Room

Preparation
Define five microphone positions in the sending and receiving room, distributed within the maxi-
mum permitted space throughout each room. The positions shall be in a different plane relative to 
the room boundaries and shall not form a regular grid. For example, mark the positions on the floor 
with a tape. The following minimum distances apply:

•	 0.7 m between microphone positions

•	 0.5 m from any room boundary

•	 1.0 m between any microphone position and the speaker

It’s recommended to vacate the room during the level measurement as the operator introduces ad-
ditional absorption

Measurements
•	 Measure the sending and receiving sound level spectrum 

LZeq at each microphone position for a measurement pe-
riod of 15 seconds.

•	 Store the readings on the XL2.

Noise Spectrum in the Receiving Room

Outdoor Area Receiving Room

L1 L2

Mic Pos. 3

Mic Pos. 5

Mic Pos. 1

Mic Pos. 4

Mic Pos. 2

Measure the Sound Levels in the Receiving Room - Top View
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4.5 Reverberation Time in Receiving Room

Preparation
•	 Move the Dodecahedron Speaker DS3 to the receiving 

room.

•	 Select three microphone positions in the receiving room.

•	 Select the RT60 measurement function on the XL2 Sound 
Level Meter.

•	 Select the 1/3 octave resolution on the XL2.

Reverberation Time T

Measurement
•	 Start the measurement on the XL2.

•	 Start / stop the test signal. 
Guideline: Set the on/off cycle time for the signal longer than the expected reverberation time.

•	 Measure at least two decays per position - better three decays.

•	 Stop the measurement on the XL2.

•	 Store the readings on the XL2.

Outdoor Area Receiving Room

Source

Mic Pos. 3

Mic Pos. 1

Mic Pos. 2

L1 L2

Measure the Reverberation Time T - Top View
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4.6 Data Analysis and Reporting

Verify and document all readings by using the Sound Insulation Reporter software. This is a PC-Soft-
ware dedicated for building acoustics professionals. Load all measurement records into the software 
and generate the sound insulation report. The software calculates the weighted ratings based on the 
reference curve shifting method in accordance with the ISO 717-1 standard.

Calculation formulas:

•	 D2m = L1,2m – L2

•	 D2m,n = D2m - 10 log (A / 10)

•	 D2m,nT = D2m + 10 log (T / 0.5)

•	 R’45° = D + 10 lg (S / A) - 1.5

•	 A = 0.16 * V / T

A Equivalent absorption area of the receiving room [m2]

D Difference between facade level and receiving room level using element meth-
od [dB]

D2m Difference between level 2 m in front of facade and receiving room level [dB]

D2m,n Normalized level difference [dB] (the level difference D is standardized to the 
equivalent absorption area of 10 m2 in the receiving room)

D2m,nT Standardized level difference [dB] (the level difference D is standardized to the 
0.5 seconds reference value of the reverberation time in the receiving room)

DnT,w Weighted standardized level difference (is the value of the reference curve at 
500 Hz after shifting the reference curve) [dB]

L1,2m Sound pressure level measured 2 m in front of facade [dB]

L2 Sound pressure level in the receiving room [dB]

R’45° Apparent sound reduction index of field measurement using element method 
[dB]

R’45°,w Weighted apparent sound reduction index using element method [dB] (is the 
value of the reference curve at 500 Hz after shifting the reference curve)

S Partition area between the outdoor area and receiving room [m2]

T Reverberation time in the receiving room [s]

V Volume of the receiving room in [m3]
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5. Sound Insulation Reporter Software

Sound Insulation Reporter - Airborne Sample Report
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6. Know How

6.1 Diffuse Sound Field

One of the assumptions commonly made in sound insulation measurements is that the sound field 
in a room can be considered as being diffuse (= the sound energy density is uniform throughout the 
space). This is not strictly correct because diffuse sound fields don’t occur in real box-shaped rooms 
with stationary surfaces and absorbent boundaries. However, in the field situation there are some 
rooms in which there are close approximations to a diffuse sound field in the mid and high frequency 
ranges. In frequency bands lower than about 400 Hz in general and especially lower than 100 Hz, 
no diffuse-field conditions in the test room can be expected especially when room volumes of 50 
m3 or less are considered.

The preceding described measurement procedure allows for measurements to be taken without 
any knowledge as to whether the sound field can be considered as diffuse or non-diffuse.

6.2 Source Position

For airborne sound insulation measurements in non-diffuse sound fields it is necessary to excite the 
majority of the modes in the source room. For this reason, loudspeaker positions near the corners 
are used in box-shaped rooms as well as other shapes of room. Many more modes are excited by 
the source in a corner position than a central point. In addition, it is necessary to take average mea-
surement from more than one source position. (Sound Insulation by Carl Hopkins, 2007, Elsevier & 
Revision of international standards by Carl Hopkins, 2015, Elsevier)

6.3 Sound Reduction Index R

The sound insulation capabilities of a particular wall, ceiling, or component can be measured in a 
laboratory, and a sound reduction index R assigned to it. For such laboratory measurements it’s 
important that the sound transmitted from the sending room into the receiving room not directly 
through the partition under test (e.g. via the side walls) is at least 15 dB below the sound transmitted 
directly through the partition.

Sending Room Receiving Room

L1 L2

Pa
rt

iti
on

Side wall Side wall

Default room layout
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6.4 Apparent Sound Reduction Index R’

In an actual building (outside of the laboratory), sound may find a way around the main room-sepa-
rating partition e.g. through a window or an electric wiring channel; the sound level in the receiving 
room is not just the sound transmitted through the partition itself. Therefore, the so-called Apparent 
Sound Reduction Index R’ is measured.

6.5 Normalized level difference Dn

The normalized level difference Dn is used for situations where there is no common partition area 
or where the partition area is not easily determined (e.g. fan opening, ventilation, etc.). The sound 
pressure level is measured in the sending and receiving room and the difference D calculated. As 
the level in the receiving room depends on the absorption within the room, the level difference is 
normalized with the actual absorption area in the receiving room in relation to a reference absorp-
tion area of 10 m2. In relation to the sound insulation index R, a normalized level difference Dn of, for 
example, 40 dB can be seen as a wall area of 10 m2 with R = 40 dB.

Receiving Room

Sending Room

L1

L2

Room layout without common partition area
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6.6 Standardized level difference DnT

The standardized level difference describes the sound insulation between two rooms. This term is 
commonly specified in local standards with minimum requirements. The sound pressure level is 
measured in the sending and receiving room and the difference D calculated. As the level in the 
receiving room depends on the reverberation time T in the room, the level difference is standardized 
to the measured reverberation time in the receiving room in relation to a reference reverberation 
time of 0.5 seconds.

6.7 Related Standards

ISO 16283-1 Acoustics — Field measurement of sound insulation in buildings and of build-
ing elements — Part 1: Airborne sound insulation 

ISO 16283-2 Acoustics — Field measurement of sound insulation in buildings and of build-
ing elements — Part 2: Impact sound insulation

ISO 16283-3 Acoustics — Field measurement of sound insulation in buildings and of build-
ing elements — Part 3: Façade sound insulation

ISO 717-1 Acoustics — Rating of sound insulation in buildings and of building elements 
— Part 1: Airborne sound insulation

ISO 717-2 Acoustics — Rating of sound insulation in buildings and of building elements 
— Part 2: Impact sound insulation

IEC 61672-1 Electroacoustics – Sound level meters – Part 1: Specifications

IEC 61260-1 Electroacoustics – Octave-band and fractional-octave-band filters – Part 1: 
Specifications

IEC 60942 Electroacoustics - Sound calibrators

ISO 3382-2 Acoustics — Measurement of room acoustic parameters — Part 2: Reverbera-
tion time in ordinary rooms
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7. Sound Insulation according ASTM

7.1 Airborne Sound Insulation

ASTM specifies the measurement of airborne sound insulation between two rooms in the stan-
dards E336 and E413.

Calculation formulas:

•	 NR = L1 - L2

•	 NNR = NR + 10 log (T / 0.5)

•	 ATL = NR + 10 log (S / A)

•	 A = 55.26 * V / (c * T)

•	 c = 20.047 * SQRT (273.15 + t)

ATL Apparent transmission loss [dB]

ASTC Apparent sound transmission class [dB] (single number rating obtained by 
applying the classification procedure of Classification E413 to apparent 
transmission loss data)

A Sound absorption in the receiving room [m2]

c Speed of sound [m/s]

L1 Sound pressure level in the sending room [dB]

L2 Sound pressure level in the receiving room [dB]

NR Noise reduction between the sending and receiving room [dB]

NIC Noise isolation class [dB] (a single-number rating calculated in accordance 
with Classification E413 using measured values of noise reduction)

NNR Normalized noise reduction [dB] (the level difference D is standardized to the 
0.5 seconds reference value of the reverberation time in the receiving room)

NNIC Normalized noise isolation class [dB] (a single-number rating calculated in 
accordance with Classification E413 using measured values of normalized 
noise reduction)

S Partition area between the sending and receiving room [m2]

t Room temperature [°C]

T Reverberation time in the receiving room [s]

V Volume of the receiving room in [m3]
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7.2 Impact Sound Insulation

ASTM specifies the measurement of impact sound insulation in the standards E1007 and E989.

Calculation formulas:

•	 ANISPL = ISPL - 10 log (10 / A)

•	 RTNISPL = ISPL - 10 log (T / 0.5)

•	 A = 55.26 * V / (c * T)

•	 c = 20.047 * SQRT (273.15 + t)

A Sound absorption in the receiving room [m2]

AIIC Apparent impact insulation class [dB] (a single-number rating derived from 
values of ANISPL in accordance with Classification E989, formerly FIIC for 
field impact insulation class)

ANISPL Absorption normalized impact sound pressure level [dB]

c Speed of sound [m/s]

ISPL Impact sound pressure level produced in the receiving room by the operation 
of the standard tapping machine on a floor-ceiling assembly [dB]

ISR Impact sound rating [dB] (a single-number rating derived from values of ISPL 
in accordance with Classification E989)

NISR Normalized impact sound rating [dB] (a single-number rating derived from 
values of RTNISPL in accordance with Classification E989)

RTNISPL Reverberation time normalized impact sound pressure level [dB]

t Room temperature [°C]

T Reverberation time in the receiving room [s]

V Volume of the receiving room in [m3]
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7.3 Facade Sound Insulation

ASTM specifies the measurement of facade sound insulation in the standards E966 and E1332.

Calculation formulas:

•	 OINR = Lfree - Lin

•	 OINR = L2m - Lin - 2 dB

•	 OINR = Lflush - Lin - 5 dB

•	 AOITL = OINR + 10 log (S * cos Q / A) + 6 dB

•	 A = 55.26 * V / (c * T)

•	 c = 20.047 * SQRT (273.15 + t)

A Sound absorption in the receiving room [m2]

AOITC Apparent outdoor-indoor transmission class [dB] (a single-number rating cal-
culated in accordance with Classification E1332 using measured values of 
apparent outdoor-indoor transmission loss)

AOITL Apparent outdoor-indoor transmission loss [dB]

c Speed of sound [m/s]

L2m Nearby microphone method - sound pressure level measured 2 m in front of 
facade [dB]

Lflush Flush microphone method - sound pressure level measured very close to the 
facade [dB]

Lfree Calibrated source method - sound pressure level of the source calibrated in 
free-field environment at the same distance that the source is to be facade 
[dB]

Lin Sound pressure level in the receiving room [dB]

OINIC Outdoor-indoor noise isolation class [dB] (a single-number rating calculated 
in accordance with Classification E1332 using values of outdoor-indoor noise 
reduction)

OINR Outdoor-indoor noise reduction [dB]

S Partition area between the outdoor area and receiving room [m2]

t Room temperature [°C]

T Reverberation time in the receiving room [s]

Q Angle of incidence of test sound [°]

V Volume of the receiving room in [m3]
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7.4 Related Standards

ASTM E336 Standard Test Method for Measurement of Airborne Sound Attenuation be-
tween Rooms in Buildings

ASTM E413 Classification for Rating Sound Insulation

ASTM E1007 Standard Test Method for Field Measurement of Tapping Machine Impact 
Sound Transmission Through Floor-Ceiling Assemblies and Associated Sup-
port Structures

ASTM E989 Standard Classification for Determination of Single-Number Metrics for Im-
pact Noise

ASTM E966 Standard Guide for Field Measurements of Airborne Sound Attenuation of 
Building Facades and Facade Elements

ASTM E1332 Standard Classification for Rating Outdoor-Indoor Sound Attenuation

ANSI/ASA 
S1.4 / Part 1

American National Standard Electroacoustics - Sound Level Meters - Part 1: 
Specifications (a nationally adopted international standard IEC 61672-1)

ANSI/ASA 
S1.11 / Part 1

Electroacoustics - Octave-band and Fractional-octave-band Filters -Part 
2: Pattern-evaluation Tests (a nationally adopted international standard IEC 
61260-1)

ANSI/ASA 
S1.40

American National Standard Specifications and Verification Procedures for 
Sound Calibrators

IEC 60942 Electroacoustics - Sound calibrators

ASTM E2235 Standard Test Method for Determination of Decay Rates for Use in Sound 
Insulation Test Methods
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